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1 Introduction

The 6th version of asix system has been enriched in the reporting system based on Microsoft
Reporting Services.

Microsoft® SQL Server™ 2008 Reporting Services is a comprehensive server platform designed to
meet a broad range of enterprise-wide reporting-related needs. The Reporting Services (in fact a
component of the SQL Server 2008 database) enable report creation from various data sources;
report environment management (planning the moment of report generation/subscribing/access
control), as well as delivering reports to the users in the format and the way most convenient for
them. The delivery methods include e-mail subscription and embedding the reports in business
applications and/or Web portals.

In order to be able to cooperate with the Reporting Services reporting platform, the asix has been
extended by the following components:

e Askom.Data.Host program

e AsRaport query editor

e AsixConnect database (run on a Microsoft SQL server)

e independent alarm archiver to store alarms in Microsoft SQL database.

The AsixConnect database is a key element. Its stored procedures with the use of Askom.Data.Host
share process data from asix applications to the reporting environment. The AsRaport query editor
plays a vital role in the report designing phase as the tool used to work out necessary SQL queries.
Data from asix applications retrieved by the queries are used by the Report Builder or the Report
Designer client applications of the Reporting Services environment to generate final reports. The
AsRaport program is a visual editor so that SQL queries may be constructed even by users not
familiar with syntax of the Structured Query Language.

Report Builder is a tool that enables the workers without programming skills to construct report
definitions for individual report generation ad hoc (on demand) by end users. The Reporting Services
environment is similar to the Microsoft Office package and may be intuitively operated especially by
persons acquainted with the Office Excel or Access program.

Report Designer is a very flexible and productive reporting environment for programmers and
advanced report designers. It is a component of SQL Server Business Intelligence Development Studio
of Business Intelligence programming environment based on the well known Microsoft Visual Studio
programming interface. Simple reports may be quickly and easily developed with the help of the
Report Wizard, more sophisticated ones may be worked out in visual development environment of
the Report Designer platform.
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Fig. Architecture of the interface between the asix system and the Reporting Services environment

Users who develop reports that are going to retrieve some data from asix system applications
simultaneously works in AsRaport interface and Report Builder/Designer interface.

The AsRaport and Askom.Data.Host.exe programs must be first configured and the AsixConnect
database must be created to get the asix system ready for cooperation with the Reporting Services
environment.

Design works on each new report form starts from defining syntax of SQL queries posted to database
of stored procedures in order to retrieve source data, on which the reports are to be based; the
AsRaport query editor is used to that end. Next, report layout must be specified in the Report
Builder/Designer program - it demands a layout template with pre-defined data sections (tables,
arrays, charts) to be selected, selected data elements to be placed in the project view, and suitable
filtering criteria to retrieve source data for the reports to be defined. Report Builder/Designer may
also be used to add new computational fields to the report form, almost arbitrarily format
appearance of the report, and to view/print/Web-publish the report. A completed report form is
stored on the Reporting Services central report server. The server shares the stored report forms
throughout the entire enterprise using various methods, including making them available to Internet
browsers.

More information on generation of reports in SQL Server 2008 Reporting Services may be found on
the Microsoft Webpage.

1.1 Software requirements

SQL Server 2008 Service Pack 1 must be installed for cooperation of the asix 6 system with the
Microsoft Reporting Services environment.



2 Access to asix system data

To use Microsoft Reporting Services, first of all install MS SQL Server 2008 on the computer, on which
the report forms are to be developed. The procedure to configure access to application process data
that are to be used as report source data includes the following steps (discussed in subsequent
chapters below):

1. AsixConnect database creation.
2. AsRaport environment configuration.

3. Running Askom.Data.Host.exe.

2.1 The AsixConnect database

AsixConnect database stored procedures with use of the Askom.Data.Host program retrieve process
data from asix applications and make them available to the reporting environment.

Use the Architect program to create AsixConnect database. It is the first step of the procedure to get
the asix system ready for reporting based on Microsoft Reporting Services.

ATTENTION: AsixConnect database is indispensable if asix application process data are to be used by
the reporting system.

To create AsixConnect database with access process data of an asix application:

1. Run the Architect program and open in that program the asix application configuration file.

2. Run the AsRaport set-up program:

Architect > Application menu> Configure Reporting System AsRaport > AsxConnect database
tab

3. Select MS SQL server name for the AsixConnect database, select the to-be-used user
authentication method, and click the Create Database button.

Three options used to select method to authenticate AsixConnect database users include:
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1. Log-in as the current Windows user — use operating system user credentials

2. Log-in as a user of MS SQL Server named ‘_asix_internal’ — such user was automatically

created by the asix package installer if only it was running on a computer with previously

installed MS SQL server

3. Log-in as the specified user of MS SQL Server — enter credentials of an user defined via the
Architect program in the AsRaport set-up program prior to creating the AsixConnect database.

Configurator of the AsRaport reporting system '

|nformation | Mame of the server computer |.ﬁ.si:-:l:|:|nnect databasze | Feports server

]

rAzikConnect databaze

kicrozoft SOL server name |

[ atabaze name |.-’-'-.ei:-:Eu:-nnenl

i1 Log in az the current Windows user
%1 Login as a user of Microsoft SAL Server named ' asiy_intemal

i1 Login as the specified user of Microzaft SAL Server:

MHame |

Paszward |

Command will create database AsisConnect on specified local Microzoft SOL Server

Create a databaze if pou have nat created when vou installed ASE.

LCreate databasze

2008 5P1.The database will be containing stored procedures which provide data from
azix gystem application. AziZConnect database iz required by AsF apart reporting system.

oK.

LCancel

Fig.: ‘Configurator of the AsRaport reporting system’ window — AsixConnect database.
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2.2 The AsRaport query editor

Configuration parameters of the AsRaport query editor include:
e asix application server computer;

e name of the report server.

The following application parameters are retrieved from the indicated asix application server

computer:
e location of the variable definition database,
e network name of the alarm server,

e name of the MS SQL server and alarm database name.

Give attention to...

Lcation of the variable definition database is declared in:
Architect > Databases > Variable Definition Base > Format tab

Network name of the alarm server is declared in:
Architect > Fields and Computers > Alarms system > Alarms/Network Name tab

Name of the SQL server and alarm database name are declared in:
Architect > Fields and Computers > Alarms system > Archive /[Microsoft SQL Server tab

To declare asix application server computer:

1. Run the Architect program and open in that program the asix application configuration file.

2. Run the AsRaport set-up program:

Architect > Application menu > Configure reporting system AsRaport > Name of the server
computer tab

3. Drop down list of server names, select the name of computer and click OK.
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Configurator of the AsRaport reporting system X|

Information I Mame of the server computer E AspConnect database | Reports server

~Mame of the server computes of Aso: applicator:

1
=
|

From the configuration of the curent applicabon folloveng parameters s ead:

- location of the vanable definiion: base
Databases -» Vabase -» Format

- etwaik name of the alaim server
Fields and Computers -> Alamns System -> Alams - Network name

- name of the SOL server and database containing alamns
Fields and Computers -» Alams System -» Archive > Microsoft SOL Senver

[ ]| comel |

Fig.: ‘Configurator of the AsRaport reporting system’ window — Name of the server computer.

Declaration of MS Reporting Services report server is necessary to be able to open reports
generated within the MS Reporting Services environment directly from the asix system application

level (using the AsRapView module of the asix system).

To declare report server:

1. Run the Architect program and open in that program the asix application configuration file.

2. Run the AsRaport set-up program:

Architect > Application menu> Configure reporting system AsRaport > Reports

server tab
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3. Declare report server address and name of the folder within the server, as well as select the
method to be used to authenticate users.

4. Click OK.

Three methods to authenticate report server users include:

1. Log-in as the current Windows user — use operating system user credentials.

2. Log-in as the ‘AskomInternal’ Windows user automatically created by the asix package
installer.

3. Log-in as the specified Windows user — enter credentials of an user defined via the Architect
program in the AsRaport set-up program

Configurator of the AsRaport reporting system : 5[

|nfarmation | Mame of the server computer | AgixConnect databaze | Reports server

—Microzoft Reporting Service

Address of the reports server | |

Mame of the directary in the reports zery | |

1 Login as the current Windows user
1 Login as the ‘Windows user Askomlntermnal

1 Login a3 the specified \Windws user

Mame | |

Pazsword | |

{H] Cancel

Fig.: ‘Configurator of the AsRaport reporting system’ window — Report server.
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2.3 The Askom.Data.Host.exe program

The Askom.Data.Host program must be running if retrieval of process data from asix application is to

be possible. By default the asix package installer puts the program within the package C:\Program
Files\Askom\Asix main folder.

10



3 AsixConnect SQL queries built in AsRaport

The AsRaport query editor is run by the AsRaport.exe executable put by default by the asix package
installer into the package C:\Program Files\Askom\Asix main folder.

The Tools and View tabs at the top part of the main window of the editor display collections of tools.
The remaining part of the window is consumed by Queryl, Query2,... tabs used to define various
queries to the database of process value archive and to the database of variable definitions.

f @ AsRaport

| Tools | View
£ colact
R
I'ﬁ'l Insert
Open application || Mew guery - Mew query - variable  Run % Copy |
flle... archival data definitions database f Remave
File Query Column /Raow
|-Queryt- | (]
Period
Beginning End The length of the interval [s]
b B [ B[ )
The value to be input — — — — -
by the user (=] |-'§--§-\-‘SZE--: | = |_-f-.-5.\-:.-C | = |_.E,.E,\._,_ = |
Column list
| Name | Agregate | Alias |
starttime start Start Time
T —
=
Query result
v

Fig: AsRaport — main window — the tab for a query to the database of process value archive.

The Tools tab includes:
Open application file — open the asix application configuration file (XML file).

New query — archival data — add a tab for a new query to the database of process value
archive.

11
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New query — variable definitions database — add a tab for a new query to the database of
variable definitions.

Run — display results of the so-far defined query.

Copy — copy query defined in the AsRaport window to the Windows Clipboard (to paste it
later at the report development stage to the Report Builder/Designer query definition
window).

Paste — paste a query from the Windows Clipboard to the AsRaport window.

Select — select process variable.

Insert — insert a new row to list of columns (in case of a query to the database of process
value archive) or a new row to list of attributes/variables (in case of a query to the database
of variable definitions).

Remove — remove the highlighted row from list of columns (in case of a query to the

database of process value archive) or list of attributes/variables (in case of a query to the
database of variable definitions).

Tools of the View tab are used to select styles and colors used in the AsRaport window to control its
appearance.

Each Query tab opened by the New query — archival data command displays the following elements:

12

Specifications of the period to be covered by the query:
Beginning — beginning of the period
End — end of the period
The length of the interval [s] —interval between subsequently retrieved process
variable values (the entire query period is divided into constant-length time
intervals).
Column list — list of fields (report columns) to be presented in the report. Click in the new
row in the Name column, then click the |*: button to drop down selection list of all pre-
defined field names:
starttime — interval start time

endtime —interval end time

shiftnumber — operator shift number. Three shifts have been pre-defined: 6 am-2
pm (the 1% shift); 2 pm—=10 pm (the 2" shift); and 10 pm—6 am (the 3™ shift).

shiftdate — date when the given shift commenced.
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For each query field an Agregat (aggregate: averageO, average, delta, end, max, min,
range, start, Total, quality_bad, quality_good, quality_uncertain) and an Alias may be
defined. The aggregate is calculated for each interval using all archived data
belonging to that interval.

| Name
starttime

| Alias |
Start Time
By End Time

| Agregate

start

éstart
average
averagel
delta

end

max

mir
Query result range

|

total

quality_bad

quality_good
quality_uncertain

endtime

Fig. The query field declaration for a query to the database of process value archive.

Query result — result of a query posted to the database of process value archive.

: g | Tools | View
= = T - YL R
i Insert
Open appiication | New query - New query - variable  Run 33 Copy | ..
fle... archival data definitions database t Remave
File: Query Column/Row
[-quenss| =
Period
Beginning End The length of the interval [s]
[Mure [  [oav+ip ] [ o]
The value to be input -
by the User & [para | = [paramend | D [paraminterva |
Column fist
|| name Agregate | atias
starttime start [Start Time]
endtime start [End Time]
ADs2 average
AD46 start
pes e N

Wynik zapytania - liczba rekordéw: 417

Start Time End Time

05/10/2010 17:04 05/10/2010 17:05 20 17
05/10/2010 17:05 05/10/2010 17:06 20 17

ADB2 | AD46 | A4S
DETROIERLBVAED 05/10/2010 17:04| 107 | 104 | 107
82
82

[IEY

<l

Fig. The tab for a query to the database of process value archive.

Each Query opened by the New query - variable definitions database command displays the

following elements:

13
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Attribute list — list of attributes of variables to be presented in the report.
Variable list — list of names of variables to be presented in the report.

Query result —results of the query posted to the database of variable definitions.

i g y e pp\Fa \ ble_base.mdb

Layout of the result table
(@ Atiribute names are names of columns, row contains the values of selected attributes of one variable

(0 Variable names are names of columns, row contains the values of one attribute of selected variables

Attribute list Variable list
| [name Aizs || Name
—
i: Description AD43
¥ |AD3E [o]

‘Wynik zapytania - liczba rekordow: 3

Name | Description
LN sl Flue gases temperature before mister

AD43  Flue gases temp. between [ &I pl.

AD38  Vapours temperature before furnace

| Tools || view
V= R = B - Y
,-ﬁ-| Insert
Open application | Mew query - New query - variable  Run EE Copy |
file... archival data definitions database !J Remove
File Query Column/Row
Query1 | Query4. | =

Fig: AsRaport — main window — the tab for a query to the database of variable definitions.




3 AsixConnect SQL queries built in AsRaport

3.1 Data retrieval — AsixConnect database stored procedures

The AsRaport query visual editor may assist users who are not familiar with syntax of the SQL
language. However, some users may prefer to construct the queries — including queries to alarm
archives — on their own. Time-related parameters of the query (periodStart, periodEnd,
resamplelnterval, periodLen) may be specified in local time, or in the OPC time format (see the
Date/time/period OPC format section below). Retrieval of archived process data, data from variable
definition database, alarms from the SQL archive, and alarms from file archives is discussed in
subsequent sections below.

3.1.1 Date/time/period OPC format

The OPC time format

The syntax:

keyword +/- offset number +/- offset number ...

‘keyword’: NOW, MINUTE, HOUR, DAY, WEEK, MONTH, YEAR
‘offset’: S, M, H, D, W, MO, Y

Examples: DAY-1D, YEAR+1MO

The OPC duration format

The syntax:

+/- offset number +/- offset number ...
It doesn't contain ‘keyword’

‘offset’: S, M, H, D, W, MO, Y
Examples: 5M, 1H, 12H, 1MO, 1D+12h

3.1.2 Retrieval of archived data

ReadProcessed periodStart, periodEnd, resamplelnterval, columnl, column2, column3, ...

Time period specification:
periodStart, periodEnd: date, for example: '2009-1-1 0:0:0°

resamplelnterval: number of seconds

Columns with variable values:
e Variable name: ‘A00C’
e As before + alias: ‘A000 as [Flue gases temp.]’
e Aggregate and variable name: ‘avg(A000)’
e As before + alias: ‘avg(A000) as [ Averaged flue gases temp.]’

Time columns:

15
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stamp time of interval start — ‘starttime’
stamp time of interval end — ‘endtime’
date of shift start — ‘shiftdate’

number of shift — ‘shiftnumber’

3.1.3 Retrieval of data from variable definition database

Retrieve data from the database of variable definitions:

ReadAttributes variableNames, columnl, column2, column3, ...
variableNames: the list of variable names, for example.
‘A000, A004, A00S8’

Retrieve and transpose data from the database of variable definitions:

ReadAttributesTranspose attributeNames, column1, column2, column3, ...
attributeNames: the list of variable attributes, for example.
‘Name, Description, Unit’

3.1.4 Retrieval of historical alarms (SQL archive)

Retrieve historical alarms from the SQL archive:

ReadProcessedHistoricalAlarms resourceName, periodStart, periodEnd,

alarmldPattern, alarmTextPattern, alarmTextLang

only alarms that were initiated within the specified period will be retrieved

alarm start/end/confirmation date, ID, text and duration will be retrieved
periodStart, periodEnd — period in local time/OPC time format

alarmldPattern — empty, alarm ID, alarm template or list of IDs, e.g.
1,23,
1-3

alarmTextPattern — alarm text or its template e.g.

*<text>*
alarmTextLang —alarm language ID (‘pl’ for Polish)

Alarm activity periods

ReadProcessedHistoricalAlarms_ActivePeriods resourceName, periodStart,
periodEnd, alarmldPattern, alarmTextPattern, alarmTextLang

only alarms that were active within the specified period will be retrieved

each alarm start/end date earlier/later than the query period start/end date will be
replaced with the query period start/end date, respectively.

Sum of activity period lenghts

16

ReadProcessedHistoricalAlarms_ActivePeriodTotal resourceName, periodStart,
periodEnd, alarmld, alarmTextPattern, alarmTextLang
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e length of the period during which the alarm was active within the specified query
period will be returned.

3.1.5 Retrieval of historical alarms (file archive)

e ReadHistoricalAlarmsOpc periodStart, periodLen, alarmldRange, alarmTextMask,
alarmType, alarmStatus, maxNumberOfAlarms
e Alarm start/end dates will be returned as separate rows.

17






4 Designing reports in Report Builder

Basic steps of the procedure that must be performed to develop a report utilizing some values of
process variables/variable definitions retrieved from asix system applications are described below
using an example of the “Factory” demo application delivered with the asix package. Reporting
Services from the SQL Server 2008 Service Pack 1 version Express have been used. For detailed
instructions see documentation of the Report Builder program.

Main window of the Report Builder program in version 2 is shown in the figure below.

@- . Untitled - Microsoft SQL Server Report Builder R ]
| romdH]  tns=r(T)

=y | %

B [ & | r—

RunJ pste ~ ||[B I U \ - :.-\“ Iy

] Merge

7 Selit

|5 Align ~

L]
0 (|

Views  Clipboard Font Paragraph Border Number Layout
Report Data . . . - 12 - 1} - 14 - | Properties
MNew = Edt.. X & & | Report
Ll Buit-n Fields : Eil=
{3 Parameters . .
2 mages = |Click to add title | == =

"
w
&=
wn
-
~
@
-
=]
=

Code
El Data Only

Dataklementi
DataElementS Attribute

| _! | Datasch
- K %*{ ronete

b Click to add data

i CataTranstorn
. T:‘b;‘eﬁ:r Chart E) General
i Author
Drescription
Width 432pt
~/|B Localization
Deseriptionle
Language
Bl Other
AutoRefresh 0
ConsumeCont False
CustomProper
El Page
BackgroundC[] Automatic __|
B Backgroundin
4 * i@ BorderColor Black
A=l rRow Groups ff column Groups - | BorderStyle  None
[ BorderWidth 1pt
& Columns
B InteractiveSize &5in; 11in
Assemblies

Specifies the assemblies that the
report referénces.

by Mo current report server

Fig. Report Builder - main window.

Form used to define new reports contains by default report contents, page footnote, and the
following elements:
e text box with the “click to add title” prompt
e link to the table/matrix wizard and link to the chart wizard
e the embedded [&ExecutionTime] field in the footnote (to add report execution
date/time to each page of the report at page bottom).
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4.1 Create a new report

Click the Start button and select the Programy/Microsoft SQL Server 2008 Report Builder/Report
Builder 2.0 option to create a new report. The displayed Report Builder window will show new report
in the project view.

4.2 Declare data source/layout/format (wizard)

The first step is to select source of the to-be-reported data and to indicate the format, in which the
reported data are to be arranged. Data presented in examples below are arranged in tables.

Table may be added to the report using the table wizard. The wizard helps to define links to data
sources, to create query specifying which data are to be reported, to organize data in some groups,

and to add summary rows (in which data contained within the group in question are aggregated).

1. Click the Design button to switch to the project view.

|J

J Rur@
L&/_._ [l 1 ] |1
Y -
Design | Zoom First Previous “ Mext
Views Zoom Mavigation

Fig. Design button to switch to the project view.

2. Click the Table or Matrix icon within the Click to add title area.

20



4 Designing reports in Report Builder

1 o | e s 1am I
CE| PR Split
e “ [z ufa-[la £ s % 0w || =
|5 Align ~
board Faont Paragraph Border Number Layout
i 2 | 3 -4 -5 -6 -7 8 -9 10 11 12+ 13 - 14 - Properties

X & 3 — Report
Sields
ters

Click to add title T

- Code
B Data Only
Clickto add data DataElement
DataElement Attr
; DataSchema
r? @ %& DataTransfol
General
Authar
Description
Width 432
B Localizati
Descriptionl

Table or Chart =2
- Matrix

[&ExecutionTime

Language

B Other
AutoRefresh 0
ConsumeCan Fal

CustomProp
M Pane
Fig. 'Click to add title' area.
The ‘Choose a connection to a data source' window appears.
X

Choose a connection to a data source
Choose a published data source, or create a connection for use only in this report,

Data Source Connecticns:

Erowse... | New...

Help | = Back Mext = Cancel

Fig. 'Choose a connection to a data source' window.

List of data sources appears, if some folder with shared source data has been defined on
the report server. Otherwise such folder (data source) must be defined.

3. Click the New... button to add a data source from the report level.

21



AsRaport

22

4. Select the 'Microsoft SQL Server' connection type, then click the Build button to define

connection properties.

New Table or Matrix x|
Choose a connection to a data source
Choose a published data source, or create a connection for use only in this report.
Data Scurce Connections:
Data Source Properties ﬂ
o
Change name, type, and connection options.
Credentials
Mame:
IDataSourcel
Select connection type:
II\-]icrosoft SQL Server j
Connection string:
Click here to type or paste aconnedfinn strinn Build... I
Connection Properties 2=l
&
Data source:
IMicmsoﬂ SQL Server (SqlCliert) Change... |
Server name:

Helg

™ use single transaction wi I

Help |

Fig. 'Connection properties' window.

5. Enter path to the AsixConnect database.

 Log on to the server

¥ se Windows Authertication
£ Use 5QL Server Authertication

Wzer name;: I

Fazsword: I

™| Save my password

- Connect to & database

(% | Select on enter & database rame:

° fttach & database file:

I Browse,.. |

i

Logical mame:
Advanced... |
Test Connection | )8 I Cancel |
4

_I Cancel |

6. Click OK to close the ‘Connection Properties' window, another OK to close the 'Data Source
Properties' window, and Next to proceed with the wizard.

ATTENTION: The above procedure may be used to define data sources from the report level.
However, in order to be able to freely modify reports stored on a report server, the data
source should be declared on that server, too. Such sources are automatically displayed on
the 'Choose a connection to a data source' wizard screen. This may be done (for example)
using the Report Manager tool, which may be invoked as follows:
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Menu Start > Microsoft SQL Server 2008 > Configuration Tools > Reporting Services
Configuration Manager > Report Manager URL > URLs

ion Manager: BPI-NOTEBOOK|SQLEXPRESS

g =113

=1 Microsoft SOL Server 2008 Reporting Services

H Reporting Services Configuration Manager

27 comect ‘ Report Manager URL
2 EPLNOTEBOCKISCUENPRESS

0 Configure a URL to access ReportManager. Click advanced to define multiple URLs, erto specify

B, service Account additional parameters on the URL,

A Ve Service UL [~Report Manager Site Identific

Virtual Directory: [Resorts squEreREsS

Database
0 URLs:

Advanced

- 0] x|
m- | hm:bi-natebaak: 2050 e WLEXPRESS Pages/Datasource asoltzrea ] | 44| [ | kD $70c 4712 b740 85753728a75¢ Displayiangen || 2|~ |
Pik Edyca Widok Ukbione Naragdzie  Pomoc
4 Uubione &I-lgmamwa..[ﬁmwtm#r xl |@-ﬂ -~ [ @ = Stonaw Bemiecrefstwo = Narzedsa « ige
; . Site Settings I=
. SQL server Reporting Services Heme |belp =
@ Homs = Data Sources = Search f,,,.:l il
ReportsDataSource ]
s TR —
Name: |ReportsDataSource
General -
B Description: zl

™ Hide in list view

¥ Enable this datz source
Data Source Type: IMichSOft S0L Server j Apply I Edt I
= |

Connection sting:  [5ata Source=aPI-
MOTEBOOK\SQLEXPRESS Initial
Catalog=AsixConnact =

Connect using:
© Credentials supplied by the user running the report

Display the following text to prompt user for a user name and password:

|T\:9c or enter a user name and password to access the data sou :l
I e T ST

Fig. Report Manager - report data source declaration.

Once data source is declared, declare a query to retrieve the to-be-reported data. Proceed
with the table wizard:

7. 0nce path to the AsixConnect database is declared, the table wizard will display the ‘Design
a query' window.

8. Provided that the query has already been created in the AsRaport editor, copy it from the
editor to the Windows Clipboard, navigate to the '‘Design a query' screen of the Report Builder
wizard, select the Edit As Text option and paste the Clipboard contents. Click the  button

! to display query results.
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x|
Design a query

Build a query to specify the data you want from the data source.

DeditAsText Fmoort... | ! Command type: [Text =l

exec ReadProcessed '"DAY', 'DAY+1D', 'iH', 'scarctcime as [Czas poczatku]', '"endtcime as [Czas -:j
kohcal®, 'a0807|

=
Czas poczatku Czas konea ADB0 —
2010-06-2500:... = 2010-06-2501:...
2010-06-2501:... = 2010-06-2502...
2010-06-2502:...  2010-06-2503:...
2010-06-2503:...  2010-06-25 04:..,
2010-06-25 04:...  2010-06-25 05:...
2010-06-25 05:...  2010-06-25 0&:...
2010-06-2506:...  2010-06-2507-...
2010-06-2507:...  2010-06-2503:... ,ll

Help | < Back Next > I Cancel ]

Fig. Report Bulider — table wizard — 'Design a query' window.

9. Click Next.

10. Arrange the fields grouping them into rows, columns or rows/columns and click Next.
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New Table or Matric

Arrange fields

Arrange fields to group data in rows, columns, or both, and choose values to display, Data expands across the page in column groups and
down the page in row groups. Use functions such as Sum, Avg, and Count on the fields in the Values box,
[l Column groups

Available fields
Cras_poczatiu
Czas_kofca
ADBO

=] Row groups = Values

Cancel

x|

Help | < Back ” Next » I

Fig. Report Bulider — table wizard —'Arrange fields'.

11. Select a layout for the table and click Next.

New Table or Matrix x|

Choose the layout

If you choose to show subtotals and grand totals, you can place them above or below the group. Stepped reports show hierarchical structure

with indented groups in the same column,
Opticns: Preview

I Show subtotals and grand totals

€ Blocked, subtotal below
¢ Blocked, subtotal above

T Stepped, subtotal above

= Expand/collapse groups

Help < Back | Mext > I Cancel

Fig. Report Bulider — table wizard — 'Choose the layout' window.
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12. Select a style for the table and click Finish.

Mew Table or Matrix

Choose a style

Styles feature different fonts and color schemes, but do not affect the basic layout. You can customize the style after you finish the wizard.

Styles:

Preview

Corparate
Forest
Generic

I\-lahoiani'

Slate

Help |

StartTime End Time

[Start_Time] [End_Time]

= Back Finish = *

Cancel

Fig. Report Bulider — table wizard — 'Choose a style' window.
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—
i ) Untitled - Microsoft SQL Server Report Builder - =B X
= HomdH]  tneer{T]  vier[d] @
= % {1 Merge
N T | =mclesl o
EFY — 2 selit
Run Paste B 7 U|(A-||A a |— :| |__J,D,
= = -
|»|] Align -
Views Clipboard Font Paragraph Border Number Layout
Report Data 1 2 3 4 5 6 | - 7 8 9 10 11 12 13 14 Properties
New - Edit.. X & # Tablixl
g Built-in Fislds A=
~{ll Parameters . .
Barderwidtk 1pt =
~{ Images CIICI‘( tO add tltle arderii p
-~ U DataSourcel B ERT
=\ ReportsDatasource DataElement
B~ Datasetl DataElement Auto
Start_Time [Start_Time] [End_Time] B Fill
End_Time Background D Mo Color
ADS52 Background:
-EZ] A102 O Filters
Filters
E General
DataSetlam DataSetl
FixedColumr False
FixedRowHe False
[&ExecutionTimg GroupsBefol 0 ||

I column Groups

e row Groups

= (Details)

KeepTogethe False
Mame Tablix1
PageBreak Mone
RepeatCalur False
RepeatRowk False
ToolTip
Localization
LabelLocD
LayoutDirect LTR
ToolTipLodD

No Rows

Calendar Default

BackgroundColor

Specifies the background color of
the item.

& Current report server http: /fbpi-notebook:8080/ReportServer_SQLEXPRESS

Fig. Report in 'Design’' view.

ﬂ ) Untitled - Microsoft SQL Server Report Builder - B x
' wm
l—‘ 43 Refresh (N % -] Document Map
% Q v 9 P P o || - ey
Poman | #mm || T T O Newt Last 0 S0P Print Page Print | Export - Perameters
- . Back Setup Layout -
Views | Zoom Navigation Print Export Optians Find
Start e End Time
2010-10-12  2010-10-12
00:00:00 01:00:00
2010-10-12 2010-10-12
01:00:00 02:00:00
2010-10-12  2010-10-12
02:00:00 03:00:00
2010-10-12 2010-10-12
03:00:00 04:00:00
2010-10-12  2010-10-12
04:00:00 05:00:00
2010-10-12  2010-10-12
05:00:00 06:00:00
2010-10-12  2010-10-12
06:00:00 07:00:00 b
2010-10-12  2010-10-12
07:00:00 08:00:00
2010-10-12  2010-10-12
08:00:00 09:00:00
2010-10-12  2010-10-12
09:00:00 10:00:00
2010-10-12 2010-10-12
10:00:00 11:00:00
2010-10-12 2010-10-12
11:00:00 12:00:00
2010-10-12 2010-10-12
12:00:00 13:00:00
2010-10-12 2010-10-12
13:00:00 14:00:00

|& No current report server

Fig. Report in 'Run'view.
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4.3 View the report

Use the Run command on the Report Builder Home tab to view the report.

Whstitied - Micrasoll SOL Semar Repae Bilder

- 4 Belreih .gl ﬁ ]j Jl Mg I

g
Nor s O R Brint  Page Poat | Bpen o Pesmeben
o Badc Setup  Lyout

Viems | Inom Baagatsan Frint Ibpar et Find

Cras kosbca  ADED

2000-06-25 S00-06-15
000030 01:00:00
L0 06-25 it e
010000 02 0000
Hiid08-25 20580625

ke 00 03:00:00
201000625 2000 025
03:00:00 0 o000 200
2000-06-2% J010-06-15
[ R i) 520000
IL-06-25 I 0I5
050000 0600000

200 0-05-35 J030-05-25
S6.0000 070000

02T 200025
a7;00:00 08:00:00

2000-08-2% 2080-06: 34

LR ] 0900200
20000625 20500 X5
LB 10:-00:00
2OL-0E-15 J00-05-2%
10:00:00 11000:00
2FiG-06-25 2000065
10:00: 00 12000:00
2010 06-25 2080065
12:00: 00 13:00:00

2000-08-25 20000625

L3

wﬁ“m“mﬂlﬂn‘ﬂ'

Fig. Report in 'Run'view.
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4.4 Add/edit data set

Data sets may be edited from the 'Report Data' window pane (the part of Report Builder main
window).

ATTENTION: Data source must be specified.
To create a data set:

1. Right-click data source name displayed in the 'Report Data’ window pane, then click the
Add Dataset... command button to open the ‘Dataset Properties’ dialog window.

If there is no data source item in the 'Report Data' window pane select New menu and Data
Source... command.

Wiews Clipboard Fol

Repaort Data

Mew = | Edit...

Data Source. ..

Dataset...
Parameter...

Image...

Fig. 'New' menu in the 'Report Data' window.

2. Accept the default name for the edited data set or enter another name into the Name field.
3. Select name of one of the existing and shared data sources displayed in the Data source
field, or click the New... button to create a new embedded data source.
4. Depending on the data source type select the appropriate Query type option:

e select the Text option for queries written in the data source query language

e select the Table option to retrieve all fields of a relational database table

e select the Stored Procedure option to run stored procedure specified by its name.
5. Enter name of the query/stored procedure/table to the Query field. Alternatively you may
click the Query Designer... button to open a graphical/text query editor, or the Import...
button to import the query from some existing report.
6. Enter maximum number of seconds the report server is to wait for a replay from the
database into the Time out field. Default value 0 means that there will be no limit at all.
7. Click OK.

The data set and its collection of fields is displayed in the 'Report Data' window pane in the data
source node of the Report Builder main window.
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. N ’ : :
/ \I ) Untitled - Microsoft SQL Server Report Builder

Homi Inser{1]  ViewV]

j 1 Merge
$ Y o9 ||+.0 .0| i Split

00 .0

=l J&| I e

: AN

Run Paste = |B I g”Av

|5 Align -

Views Clipboard Font Number Layout

Report Data '|1'2'3'4'5'6'?'8'5"10'11'12'13'14'

New - Edit.. »§ &+ =

3 Images i CIiCk tO add title
E& DataSourcel -
ERTo-osetr :

/=] Field1 ~

Click to add data

- Fe i |

Table or Chart
- Matrix

[&ExecutionTimg

B2 Row Groups fff column Groups -

Fig. The data set and its collection of fields in the 'Report Data' window pane.

To edit a dataset:

Properties

Report

DataEleme

DataScher
DataTransf
B General
Authar
Descriptior
Width
B Localizatio
DCrescriptior
Language
E Other
AutoRefre:
Consumet
CustomPra
Page
Backgroun
Backgroun
BarderCal:
Borderstyl
Baorderwid
Columns

m

HEH

HEH

HEH

Interactive!

Margins
PageSize

0OEH

References
Assemblies

Right-click the data source name displayed in the ‘Report Data' window pane, then right-click the
data set name and click the Dataset Properties button to open dataset properties window in the

query properties view.
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Dataset Properties ] x|

Parameters

Fields
Options

Filters

Help I

4 Designing reports in Report Builder

Choose a data source and create a query.

Hame:
IData.Setl

Data source:
I ReportsDataSource :l Mew...

Query type:
* Tet © Table  Storsd Procadurs
Query:

exec ReadProcessed ‘DAY, ‘DAY=-10', 'LH', 'starttime as [Czas poczatku]’, ;I % |
‘endtime as [Czas koncal, "A020°

=l

Query Designer... | Import... I Refresh Fields... I

Time out (in seconds):
1] =

oK Cancal I

Fig. 'Dataset Properties' window.

Select another category in the left window pane to switch to another dataset property.
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4.5 Embedded vs. shared sources of data

Report Builder 2.0 can link a report to a data source shared on a report server or embed a data
source into a report; in the latter case the data will be used exclusively by the report.

To be able to link a report to a data source shared on a report server one has to have access to the
server and to know data source location within the server. To embed data source one has to specify
connection and to know what privileges to specify so that the data needed within the report might

be retrieved.

Once a shared data source is selected on a report server, the server becomes the current report
server.

To create a link to a shared data source (shared connection):

1. Click the New... menu bar option in the 'Report Data’ (left) window pane of the Report
Builder main window, then click the Data Source... option to open the '‘Data Source
Properties' dialog window.

2. Accept the default name for the edited data source or enter another name into the Name
field.

3. Set the Use a shared connection or report model option to display list of shared data
sources and report models used in the report. If the list is empty, click the Browse... button

and navigate to the report server folder, in which the shared data sources reside.

4. Highlight the shared data source and click OK.

Data source name will appear in the ‘Report Data' window pane.

To embed a data source:

32

1. Click the New... menu bar option in the ‘Report Data’ (left) window pane of the Report
Builder main window, then click the Data Source... option to open the ‘Data Source
Properties' dialog window.

2. Accept the default name for the edited data source or enter another name into the Name
field.

3. Make sure the Use a connection embedded In my report option is selected.

4. Drop down the Select connection type list and select data source type e.g. 'Microsoft SQL
Server' or 'OLE DB'.

5. Using one of the following methods specify the connection string:
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e enter the string directly into the Connection string text box
o click the fx formula button to display the ‘Expression’ dialog window, enter
expression into the Set expression for: box, click OK.

6. Click the Build... button to open the ‘Connection Properties' dialog window with properties
of the above specified connection.

7. Depending on the selected data source type fill up appropriate fields of the ‘Connection
Properties' dialog window (data source type/name, credentials used to connect etc.). Click the
Test Connection button to make sure that the data source is available and that the supplied
credentials are correct.

8. Click the Advanced butoon - the ‘Connection Properties' window will appear.

9. Specify credentials to be used to connect to the data source. Data owner is responsible for
selecting acceptable credentials. Sometimes the owner decides to share data source on a
report server and sets (in the server properties) up credentials available for other users. Ask
data owner for the credentials.

10. Click OK.

Data source name will be displayed in the ‘Report Data’ window pane.

4.6 Save the report

To save the report:

1. Click the icon in the top left corner of the Report Builder main window and select the Save
As command.

2. Specify URL address of the target server report or a local computer target folder. The report
will be saved in a *.RDL file.

3. Click the Save button.
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Save As Report =]

Look in: I @' http://bpi-notebook:8080/ReportServer_SQLEXPRES

Fg
Recent Sites
and Servers

Deskiop

My Documents

My Computer

E] Data Sources

E] Raport_testowy 100
[ Raporty DEMO

E] Report Project3

B test

Mame: IUnh’ﬂEd.rdI

Save I

Items of type: IReparis (*.rdl)

j Cancel |

Fig. 'Save As Report' window.




5 Designing reports in Report Designer

Only basic steps of the procedure to define simple reports utilizing process data sources from asix
system applications have been described in this section. The “Factory” demo application delivered
with the asix package has been used as a sample application. Services from the SQL Server 2008
Service Pack 1 version Express have been used. For detailed instructions see documentation of the
Report Designer program.

‘E} Start Page - Micresoft Visual Studio 10l x|
File Edit View Tools Window Help

R T IFE Y Y - T =1

8,
< Start Page| Solution Explorer
A% Microsoft* 5
« Visual Studio 2008
Recent Projects Get News from Microsoft
Report Project3 Download the latest information for developers to the Start Page
:'__-‘] Raport_testowy Click here to enable an RSS feed that provides regularly updated articles about new
@Repnrt Project1 technologies, product tips and tricks, and upcoming events. This live feed also incudes
E-i]Re ort Projecta infarmation about service packs, community technology previews, and Beta releases of
ylRep I Microsoft products and technalogies. To view the Microsoft Privacy Policy, go to
[ panalysis Services Project1 Tools/Options/Environment/Help/Online and then dick Read the privacy statement,
Open: Project...
Create: Project...
| Getting Started -
Output -
Show output from: - | ﬁ] | "JJ _’l>| =4 | =]
|j3 Error List|
Ready 4

Fig. The main Report Designer window.

1. Run Start > Programs > Microsoft SQL Server 2008 > SQL Server Business Intelligence
Development Studio

2. Select the Create: Project... option in the ‘Recent Projects’ window pane.

3. Enter basic report parameters: its name and location. Click OK.
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I MET Framework 3.5

Project types: Templates:
Visual Studio installed templates

[H- Other Project Types

@Analysis Services Project @Import Analysis Services 2008 Dat...
J’Integration Services Connections P... ;ﬁlntegraﬁon Services Project
[H]Report Server Project Wizard [E]Report Model Project

:j] Repart Server Project

My Templates

i 5earch Online Templates...

Create a new Report Server project using Report Wizard,

Mame: I Report Project4
Location: I D:'\Documents and Settings'BPi\Moje dokumentyisual Studio 2008\projects j Browse... |
Solution Mame: I Report Project4 W Create directory for solution

OK I Cancel |

Fig. 'New Project' window.

4. Report Wizard welcome screen appears. Click Next.

=

Welcome to the Report Wizard

The Report Wizard helps you create a repart, With this wizard,
You can:

- Select a data source from which to retrieve data

- Diesign & query to execute against the dats source
- Choose the type of report you want to create

- Specify the basic layout of the report

- Specify the formatting for the report

Click Mext to continue,

[T Don't show this page again

Help | = Back | Mext = I Eimish) == Cancel |

Fig. Report Wizard - greeting window.
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5. On the ‘Select the Data Source' screen specify data source: name of the SQL server
serving the AsixConnect database and the AsixConnect database - use Edit... button
to open ‘Connection Properties' window. Click Next.

= F

Select the Data Source

Select 2 data source from which to obtain data for this report or creste a new data
SOUrCE.

! Shared date source

| I
& New data source
Mame:
IDataSnur(E 1
Type:
IMicrosoﬁ SCL Server j
Connection string:
Edit... Connection Properties x|
Credentials. .. Dtz source:
IMiEmsuﬁ SQL Server (SqlClient) Change
Server name
| 7|  PRefesh
™ Make this 3 shared data source [ Log onto the server

& Use Windows Authertication
" Use SQL Server Authertication

Help | < Back Mext > Finish > Cancel s name: |

Fassword I

™| Save my password

- Connest to & database

% Select or enter & databass name:

| =]

 Attach a database fie

I Erowse, . |

Logical name:

Advanced...
Test Connection | Cancel
4

Fig. Report wizard - 'Connection Properties' window.

6. The ‘Design the Query' screen appears. Provided that the query has already been
created in the AsRaport editor, copy it from the editor to the Windows Clipboard,

navigate to the ‘Design the query' screen, and paste the Clipboard contents into the
Query string: field.
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B Report Wizard

Design the Query
Specify a query to execute to get the data for the report.

=10l x|

Use a query builder to design your query.

Query Builder. ..

Query string:

'A036', 'A004]|

exer ReadProcessed ‘DAY, DAY +1D', "1H', 'starttime as [Start Time]', 'endtime as [End Time]', ;l

Help | < Back | Mext = Eimish) =] |

Cancel

Fig. Report wizard - 'Design the Query'.

7. Select report type: 'Tabular' or 'Matrix'. Click Next.
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=

Select the Report Type

select the type of report that vou want to create.

{* Tabular

. Matrix KXHEX HHEX KXXK XXHH XXXX
HRREE MR e R M
HERAR HEERE AEERE HREEE HERRE
HRREE MR e R M
HERAR HEERE AEERE HREEE HERRE
HRREE MR e R M
HERAR HEERE AEERE HREEE HERRE
HRREE MR e R M
HERAR HEERE AEERE HREEE HERRE
HRREE MR e R M
HERAR HEERE AEERE HREEE HERRE
HRREE MR e R M

Help | < Back | Mext = I Einish == Cancel |

Fig. Report wizard — 'Select the Report Type' window.

8. Design a layout of the data within the report (a table was selected in this
example). Click Next.
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B Report Wizard

Design the Table
Choose how to group the data in the table.

=10l x|

Available fields: Displayed fields:
AD35 Pages
ADD4
GEroup > |
Details = | Start_Time

< Remove |

*-
+

A
R M
R R R

H
R R R
e

Help | < Back | Mext = I Einish ==| Cancel

Y

Fig. Report wizard — 'Design the Table'.

9. Select table style. Click Next.
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_ioi x|

Choose the Table Style
Choose a style for the table,

XXRRKX

Forest —"

Corporate

Bold peome oo [weoe [wenr [sooor |

Orean mm EEEE T

Generic HaooT NHNH e
B RN oo e e
B RN oo e e
B R oo e NHHH
B R oo e NHHH
B R oo e NHHH
E e MM b HUXN HUHN
E e MM b HUXN HUHN
Erpe N L e HEXM HEXM
L HHME M HYNH HYNH
L HHME M HYNH HYNH
e A NI HENH HENH
WA HHNHH HHAH HENH HENH
e i Lt HEHH HAHH

Help | < Back | Mext = I Einish == Cancel |

Fig. Report wizard — 'Choose the Table Style'.

10. Specify report server and its folder, to which the reports will be transferred
(deployed). Click Next.
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=

Choose the Deployment Location
Choose a location to which to deploy the report.

Repoart server:

For a report server running in native mode, the path to the report server where the project is
deployed, for example http:/fservernamefreportserver. For a report server running in
Sharepoint integrated mode, the URL of the Sharepoint site to which the project is deployed, for
example hitp: /fservername.

Deployment folder:

Repoart Project5

For a repart server running in native mode, the path to the report folder, for example /Reparts.
For a report server running in Sharepoint integrated mode, the URL of the Sharepoint library for
reports, for example http: ffservername Shared Documents /Report Folder,

Help | < Back | Mext = I Einish ==| Cancel |

Fig. Report wizard — 'Choose the Deployment Location' window.

11. Specify report name. Click Finish. The report will be displayed in the project view.
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1Tk
Completing the Wizard 4

Provide a name and dick Finish to create the new repart, .l
]
1
Report name:
|Test Report]

Report summary:

Data source: DataSource

Connection sting: Data Source=BPI-MOTEBOOKNSQLEXPRESS: Initial Catalog=AstdConnect
Report type: Table

Layout type: Stepped

Style: Slate

Details: Start_Time, End_Time

Cuery: exec ReadProcessed DAY, DAY+1D", "1H', 'starttime as [Start Time]', ‘endtime as
[End Time]", "AD3E", "A004"

r Preview report

Help | < Back Mext = | Einish I Cancel |

Fig. Report wizard — 'Completing the Wizard' window.

2§ Report Projects - Microsoft Visual Studio

=3l
File Edit View Project Buld Debug Tools Window Help
i~ @ | % Ba |9 - ™ -] b |Debug F|EEREA-g
(B B = = = [m0% g i 1zl I I =R R o R
qT)
- Edt.. X # %

— ||[®) pesan | @ Preview
Bullt-n Fields

15| Report Projects
[ Shared Data Sources

Parameters

H Images - [ Reports
E-0; DataSource1 ) ]
- Datmsets Test Report

[Start Timel  [End Time]

Kl

4= Row Groups il column Groups + | | TestReportrdl -
= (tablel Details_Group) S = e
B Location
= oy | Flename Test Report.rdl
Eres = Full Path D\Pocuments and Setting
Show output from: = | B “ﬂ _\;‘ = ‘ =

File Name
Specifies the name of the fil.

(123 Error Liet]
Creating project Repart Prajects... project creation successful.

Fig. Final report in design view.
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12. Click the Preview button to view the report.

2§ Report Project5 - Microsoft Visual Studio =g x|

Fle Edit Vew Project Buld Debug Took indow Help
o R= - BN N I R T EERBO-g

HERER: Ji=) p[CT0 g i -] il dgif| e & 2| W o | 5240 R s B £ 2 B
HIpe

S TR - report-i Desoni| Sartre) o5 cre

e K || @ oeean [ Freven -

3 Built-in Fields - 53] Report Projects
(0@ Parameters FE S| 4 1 of 1 b M |« O3 EAHE-| 0% = _|l| -~ 3 shared Data Sources
- Images :‘ =) [ Reports
B0 DataSource1 Test Report I— - |u] TestRepart.rdl

E-E DataSeti

Start Time
Endl_Tine 10/15/2010  10/15/2010

12:00:00 AM 1:00:00 AM
10/15/2000  10/15/2010
L00:00 AM| 2:00:00 AM
10/15/2000  10/15/2010
2:00:00 AM 3:00:00 AM
10/15/2010 10/15/2010
3:00:00 AM 4:00:00 AM
10/15/2000 10/15/2010
4:00:00 AM 5:00:00 AM -
10/15/2010  10/15/2010 I
5:00:00 AM 6:00:00 AM =
10/15/2010 10/15/2010

Output S
Show output from: Build ML RR-R=Y
Build complete -- 0 errzors, 0 warnings -

4
[ Error List]
Ready in2 col'1 ch1 ™Sy

Fig. Final report in preview.

13. Select the Deploy <report_name> option of the Build menu to store the report
on the report server.
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6 Access to reports stored on report server

Reports shared on a report server may be viewed in any Internet browser. To view a report, specify

URL address of the server. In case of the MS SQL Server 2008 Reporting Services environment the
address for report server is:

http://<computer_name>/ReportServer_<SQL_server_instance_name>
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Fig. Access to reports stored on report server via Internet browser.
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Fig. Final report in Internet browser.

Reports accessed via Internet browsers may be printed and/or exported to PDF, Excel and/or Word
formats.
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7 Viewing reports directly from asix applications

Reports created within the MS SQL Reporting Services environment may be directly viewed from the
asix system application level using the AsRapView report viewer. The viewer may be started by the
ASRAPORT operator action according to the syntax:

ASRAPORT /RN=<report_name>[<report_parameters>]

where:

report_name - name of the report created within the MS SQL Reporting Services
environment (report definitions are stored in *.RDL files)

report_parameters - additional parameters of the report.

Location of reports (within the MS SQL Reporting Services report server) to be displayed in the
AsRapView viewer must be defined in the AsRapViewReportServerConfig.xml configuration file - it is
declared with the use of Configurator of the AsRaport reporting system run from Architect >
Application menu > Configure Reporting System AsRaport.
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